COFFEECUP VISUALSITE DESIGNER

A Website (Homepage) on the Internet consists of a front page and a number of sub-pages. These pages
(documents) must be available to others. Usually these pages are available through an internet provider that
keeps the pages located on a web server.

You can think of a Website as a storehouse of information and where you easily can search and navigate. The
information can be represented in many ways, typically you will see it presented as text, graphical objects or
a combination of both.

You navigate through a Website by using links (hyperlinks).

A link can be visualized in many different ways, but you can spot them by moving the mouse across one of
them and notice that the cursor changes to the image of a hand.

With VisualSite Designer you can create your own Website. It can contain as many pages as you would like,
text, graphical objects and links. You can move all these elements around on your page just by using your
mouse. The pages can also have different background properties. Usually the background of a Website is
colored white, but you can also choose different colors, fill the background with a pattern(image), or try a
gradient color to create an exciting background.

Install Software CoffeeCup:

If you have not yet installed CoffeeCup VisualSite Designer on your computer please do so
now. Navigate to W:\\CoffeeCup\full versions and double click on Visual Site Designer 5.0
full.exe this will start the install, click next and “I accept” when asked.

Start:

It is very easy to create your own Homepage in VisualSite Designer. Here you will be guided
through 8 easy steps to make your very own Homepage.

Step One:

If you already have opened a Homepage then close it now. You will find the command "Close Homepage" in
the Files menu.

Step Two: Wi
Choose the command "New Homepage" from the Files menu. This command will open the dialog box .
Navigate to W:\\Teacher Template\Teacher Template.vnu . Open. This will display a working template for
your school. Please edit this template as you wish, but remember to leave the Header & Trailer as is. Your
web design should take place between the Header & Trailer. One last important point to remember is to do a
“SAVE AS” when you save your website the first time. Thus avoiding overwriting the teacher template on
the I: drive. Please save it to your C:\My Documents and Name the file with your “username” ie (gmix).

A Homepage on the Internet consists of a front page and a number of sub-pages. These pages (documents)
must be available to others. Usually these pages are available through an internet provider that keeps the



pages located on a web server.

You can think of a Homepage as a storehouse of information and where you easily can search and navigate.
The information can be represented in many ways, typically you will see it presented as text, graphical
objects or a combination of both. You navigate through a Homepage by using links (hyperlinks).

Each time you add new pages to your Homepage they will inherit the "Name", "Width", "Height",
"Homepage background" and the "Homepage link colors" that you specify in the dialog box. The pages in
your Homepage can of course have individual settings, but by default they will have the settings you specify
in this dialog box. You can alter these default settings at any time for your Homepage by choosing the
command Files->Misc->Homepage Preferences.

The "Name" is the title that is shown in the top blue bar in the browser. "Your School Name" is in the field.
Each page in your Homepage has a background and any number of objects. In VisualSite Designer this
background can be a solid color, picture fill or a gradient color fill. Choose the solid color white as in the
example above. If the rectangle is not white just click on it and select the white color. Now click on OK. You
have now created a Homepage on your computer. Please note that this Homepage can't be seen by anyone
other than you until you choose to publish it to the Internet. After you click on OK the first (and only) page in
your Homepage is opened. Now is a good time to save it by using the command "Save As" from the Files
menu.

Step Three:

Double Click on the title bar labeled Mrs. ???? first Grade Class, by double clicking, notice that there is a red
outline around the text. You can now edit the text within the red outlined area. Click out side the area to
deselect. Single click an area and it outlines the area in blue allowing you to move, drag the item where ever
you want on the page. Double click an object outlines it in Red allowing editing and also resizing by click
and hold and drag the little boxes around the red rectangle.

You can change the width of the red rectangle by moving the mouse to one of the red arrows on the left or on
the right side of the rectangle. The height of the red rectangle is adjusted automatically to fit the text. In other
words, the only way you can adjust the height is by adjusting the width or by entering more text.

The “Object Window” that automatically opens when you double click to edit control the font or the font
size of the text you just entered . You can change the font or the font size for the text or just a few letters by
selecting them “highlighting” with the mouse. You select letters by clicking and dragging the mouse. One
you have selected the letters then select the new settings in the Object-Window. You also can Bold ,
Underline and change the text Color from the Object-Window.

You can insert any number of text objects on the page and you can can always alter a text object by selecting
the Text Tool and clicking on it. Notice that you can't edit a text object unless it has a red border which
means that is is ready to be edited. You do this by selecting the Text Tool and click on the text object.

Select the Text Tool from the Toolbox. Move the mouse over the blank page, click and drag the mouse to
mark a red area. Release the mouse-button and notice the blinking cursor in the red rectangle. This means
that you can start writing the text. Write the text " Welcome to my new Homepage".

Step Four:

Select the Rectangle Tool from the Toolbox click and drag a rectangle with the mouse. The rectangle has a
blue border and 8 handles around it. Move the mouse over the handles and notice how the mouse changes as
in the example below.



If you move the mouse over one of the blue handles on the left or the right side you can adjust the width of
the rectangle by click and dragging the handle to a new location. You can adjust the height with the handles
at the top and the bottom. You can adjust the angle width the 4 handles in the corners. The rectangle can be
moved to another location if you click in the center of the object and drag the mouse.

Notice that the text object no longer has a border around it. This is because it is the rectangle and not text that
is selected. Click on the text and notice how it gets selected and the rectangle gets unselected. Try to move,
rotate and scale the text just as you did with the rectangle. As explained on the previously page you need to
select the Text Tool and click on the text object to actually edit the text. Do that now and notice how the text
is shown in its normal state with the red border because you are now editing the text. Make a small change in
the text and select the Arrow Tool from the Toolbox and notice how the scale/rotate is restored and the text
object is shown with the blue border.

Step Five:

Lets make the rectangle red instead. Select the rectangle (select the Arrow Tool and click on the rectangle)
and click on the button Fill in the Toolbar and notice how the Inspector shows the settings for the object's fill
as in the example below.

Click on the colored rectangle to the right of "Single Color" and choose a red color. As you see the rectangle
turns red.

Step Six:

Now to view and edit page one or page two click on SHOW PAGE on the top tool bar. There have been
three or more page created for you to edit and create links to. To add a new page select Tools on the top
menu bar, click “Add Page” the “Setting for the Page” window appears, click OK to create a new page.
After your create a new black page you must copy and paste the Header & Trailer on to the new page. This
will continue the same look and feel throughout your web pages.

There are already “Hyper Links” on you template page. The “Link to my next Page” & “Page Two” & “Link
to Math Page” are all Links. These Links can be edited by double clicking the text area and highlighting the
text then click on the Link button up top. The Link window will appear for you to connect your link to. Lets
make a reference (link) from this blue ellipsoid to the first page. By doing this the visitor on your new
Homepage can actually jump from this page to the first page just by clicking on the blue object. To do this,
click on the button Link in the Toolbar. Now select the first page from the drop-down menu just to the right

of "Page". The first page is also the front page in your Homepage. Notice how a checkmark was set in "Use
Link".

Now select the first page again as the active page and insert a new text object "Click here to jump". Highlight
the word "here" in this new text object and select the second page from the page list in the Link-Inspector.
The two pages are now connected.

Step Seven:

Select the command "Preview Homepage" from the View menu. This opens the built-in browser. The first
page you see is the front page. Click on the link and notice how you jump to the other page. Now click on the
ellipsoid link to jump to the front page. You close the browser by clicking on the checkmark.

Step Eight:



Tech Support will have to create and setup your Internet Connection for you before this next step will
function. Select the command "Internet Connection" from the Tools menu. This command will open the
dialog box you see below.

Tech Support will set this up for you, if it has not been setup contact Gregg or Jesse. After this has been
setup, you can click the UPLOAD button to save you work to the Web Server. Your webpage is now on the
web server for tech support to review and then make Public. After your site is Public the whole world can
view it. To see your web pages go to: Http://www.mvsd21.org/~YourUserName then Enter. We will also
create a Link from your schools web page by your name, to your web page.

VisualSite Designer is now ready to publish your Homepage to the Internet. Click on the button Send to open
the dialog box seen below.

You can here choose between sending the changes since the last publish, or sending the complete Homepage.
Click on "Send All". Now start your browser to see the published result

Objects in VisualSite Designer

You use the tools from the Toolbox to insert objects onto your pages as described in Make your first
Homepage. There are five different types of objects: text, rectangles, ellipsoids, pictures and html objects.

The objects in VisualSite Designer are constructed in such a way that you can scale and rotate them while

maintaining the high quality at all time. If for instance your rectangle is filled with a picture, that picture-fill
will be recomputed real-time each time you scale or rotate the rectangle in order to fit the new shape exactly.

Make appealing objects

When you create an object it always has "Single Color" as the color-fill. But with the advanced settings for
fill and effects you can easily make your objects come alive. These fill and effects settings can be applied to
all objects.

Click here to see some examples or here to get a more thorough explanation of fill and effects.

Settings for the pages

To make your Homepage more appealing you can add different types of color-fill to the page-backgrounds
and not only the objects. Normally the background color-fill on pages is white but it can be any color,
pictures or gradient color-fills.

Click here to see some examples of the different types of backgrounds.

Reuse objects

If you are satisfied with a particular object (for instance a button) and want to reuse this object there are two


Http://www.mvsd21.org/~YourUserName

ways of doing this. The fastest way is by using the copy/paste commands from the Edit menu. But you can
also make a note of the width/height/fill/effects settings for the object in question and simply make a new
object with those exact settings. Clearly a more time consuming method.

Picture Tool:

Use Picture Tool to insert photo’s or clip art into your web page. Click Picture Tool move the mouse pointer
to where you want the object, then click hold and drag a box to hold the image. An “OPEN” window will
appear, navigate to where the photo or clip art is stored.

W:\\Inkom Images  (School Name) Images is a Location we have created and preloaded with clip art and
photo’s for your school. Remember to click on View Thumbnails to see images in the “open” window.

Good Luck and Have Fun.

techsupport@mvsd21.org  E-mails both Gregg & Jesse
gmix@mvsd21.org
jdunn@mvsd21.org
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